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1 Tarrojen tulostaminen Kohassa Label Maker -tydkalulla

Tarrojen tulostusohjelma Label Maker |6ytyy: Koha-Tydkalut-Tyodkaluliitinnadiset-> Label Maker
- Laita suosikiksi selaimeen
- Voi kayttaa Firefoxilla ja Chromella

Lainaus ja palautus  Asiakkaat Haku  + ™ Kori  Muita toimintoja +

Syota hakusanat Listat
Akoha e g

" Hankinnat
Lainaus  Palautus  Uusinta

Auktoritestit

Ztusivu » Tyokalut Kausijulkaisut
Asiakkaat ja lainaus Raportit Luettelo Muut tyskalut
Kommentit ﬁ Tydkalut Inventaario Lokien katselu

Woderate patron comments Tietoja Kohasta Inventoi kokogimaa Selaa jarjestelman lokeja
Kirjastokorttien luonti Tarrojen luonti Tyokaluliitannaiset

Luo tulostettavat asiakaskortit Lue tarroja ja vii Use tool plugins

Selkatarrojen pikaluonti
Luo tulostettava selkatarra sydttamalla viivakoodi. Kaytetdan tarratulostimien kanssa

>« Lavelliaker

1.1 Tarraeran tekeminen

Tee tarraerd Kohassa Tarrojen luonti —toiminnon avulla. Klikkaa Label Makerissa New > Label batch.
Tarroja tulostetaan batcheista (tarraera).

Home » Plugins » Label Maker : Home

+ Mew - # Mew from wizard - = Print b

Template
Layout
Printer profile
Label batch
Avery Standard Labels

Name

Koha avautuu uuteen nakymaan Tarrojen luonti. Syéta avautuvaan ikkunaan viivakoodit, jotka haluat
tulostaa seuraavassa tarraerassa. Jokainen viivakoodi omalle rivilleen.

+Uusi~ & Kasittele

Lisaa viivakodilla: (®)

Lisaa (O
nidenumerolla:

Lisaa viivakoodin [1354120469
perusteella: |11354077338

One number per line.
Leave empty to add via item search (temnumber)

'? + Lisaa niteet

Klikkaa Lis&éa niteet

Era saa numeron (tdssa era 134), joka on hyva muistaa, koska sita tarvitaan tulostuksessa.
Tulostamisen jalkeen valmis tarraera on tuhottava (ks. kpl 1.3.)



+Uusi» (& Kasittele v

Batch description: l:l

Liséa viivakodilla: (@)

lissa O

nidenumerolla:

Lisaa viivakoodin [1354160470
perusteella: |1354160471|

One number per line.
Leave empty to add via tem search (temnumber)

+Lisaa nitest ) Save description @ Poista valitut O Poista eraajo — Puoista kaksoiskappaleet 2 vie valitut niteet [ vie eraajon tisdot

Niteet erédssa 134

Showing 11o 4 of 4 entries  Show[20 - |entries  « Firsl < Previous  Next>  Last»  Search

% Clearfilter
Tarranumero - Yhteenveto Aineistolaji Luokka Viivakoodi Actions Valitse
1 Meilla on idea | Liukkonen, Pauliina Laina-aika 28 vk 200 LIUKKONEN 1354130469 @ Poista | | 2 vie ]
2 Bitteina ja paperilla | Lantta, Reino Laina-aika 28 vrk 655 LANTTO 13541511568 @ Poista | | 2 vie O
3 Teknisten ammattien matematiikka | N/A Laina-aika 28 vik 510 LAUNONEN 1354026047 8 rossta | [ 2 vie O
4 Yrittajan sosiaalisen median strategiaopas | Kananen, Jorma Laina-aika 28 vrk 240 KANANEN 1354174519 O

@ Poista | | B Vie

e Tassa erdan voi lisata viela lisaa niteita tai poistaa jo tuotuja nideviivakoodeja (painamalla lisda
niteet tai poista tai poista valitut).

e Tarrojen eraajot ovat henkilokohtaisia. Kukin kirjastolainen nakee vain omat eransa.

1.2 Tarrojen tulostaminen tarraeran luomisen jalkeen

Kun tulostaa tarroja, palaa Label Maker-tyékaluun. Klikkaa Print batch.

Home » Plugins » Label Maker » Home }
\r
+Mew - # Mew from wizard = & Print batch
» Templates
e Layouts

* Printer profiles

Seuraavaksi valitaan tarraeran asetukset. Valitse omassa kirjastossa kaytdssa olevat tarramallit.

Print labels

Batch: | 134 (4) .

Template: | Finn-ID 33mm x 25mm (Pa&sana 3-kifjaiminen) « |

Layout: | Finn-1D KAPEAMPI 36mm x 23mm (Arial 12) vl

S Print labels =il

Batch: tahan valitaan luomasi tarraeran numero

Template:

e Finn-ID 38mm x 25mm (Paasana kokonaan)
e Finn-ID 38mm x 25mm (P&asana 3-kirjaiminen)

Layout: oman tulostimen kayttama tarramalli

e Finn-ID 38mm x 25mm (Arial 12) -- Haaga-Helia Haagan ja Metropolian Datamax-kirjoittimet
e Finn-ID KAPEAMPI 36mm x 23mm (Arial 12) — Metropolia Karamalmi, Metropolia Myyrmaki



e Haaga-Helia Finn-ID 38 mm x 25 mm (Arial 12) -- Haaga-Helia Pasilan ja Porvoon Attune-
kirjoittimet, joissa on hivenen eri kirjoitinasetukset

¢ Haaga-Helia_ MALMI Finn-ID 38 mm x 28 mm (Arial 16) -- Haaga-Helia Malmin tarrat Attune-
kirjoitin

1.2.1 Firefoxilla tulostaminen (Haaga-Helia ja Metropolia)

Klikkaa Print label, jonka jalkeen naet tuloksen Firefox-selaimessa.

- Tarkista selaimen versio, jos tarrat menevat vinksalleen! (Firefox versio 78.4.1esr nahtavissa
asetuksissa).

E Metropolia |2 Koha » Kifjaudu Kohaan

200
LU

655

Selaimessa signumit on tulostettava selaimen Print-komennolla (I6ytyy naytdn oikeasta laidasta - kolme
viivaa ->Print).

File Edit View History Bookmarks Tools Help

Koha » Tydkalut » Tarrojen luon' X k| app1.3amk.koha.cscfifcgi-bin X
&« ¢ @ © & 25 https:/fapp1.3amk.koha.cscfi/ 11086 see o InN O ® 4 =
@ sign in to Firefox ?
200
LIU i Protections Dashboard
B} Mew Window Ctrl+N
O Mew Private Window Ctrl+Shift+P
E.' Restore Previous Session
655
LAN Zoom - %+ A
Edit X O g
l\ Library >
510 =0 Logins and Passwords
LAU & Add-ons Ctrl+ Shift+A
'ﬁ Options
,/ Customize...
Open File... Ctrl+0
240 Save Page As... Ctrl+5
KAN
é Print...
Q, Find in This Page... Ctrl+F
More >
Web Developer >
o5 What's New >
@ Help >
O i Ctrl+ Shift+Q




ozilla Firefox
Simplify Page Llose

of 2 » w | Scale | Custom.. ~ | || Portrait | |Landscape

200
LIU

Firefoxin asetukset on sadadettava ensimmaiselld kerralla Page Setup-kohdasta nain:

Margins & Header/Footer
- kaikki marginaalit 0.0
- kaikki yla- ja alatunnisteet blank

Page Setup — Format & Options
- Orientation: Landscape
-130 %

b4 Page Setup

Page Setup

Format

Options

Format & Options Margins & Header/Footer

Orientation: () JEor‘trait ® | |Landscape

% [ Shrink to fit Page Width

[ Print Background (colors & images)

Cancel

Format & Options Margins & Header/Footer

Margins (millimeters)

Headers & Footers

--blank-- ~ | | --blank-- ~ | | --blank-- ~
Left: Center: Right:
--blank-- ~ | | --blank-- ~ | | --blank-- v

Cancel

Kun asetukset ovat kunnossa, klikkaa selaimen Print-painiketta ja tee tarroista PDF:t.

e Haaga-Heliassa valitse Microsoft Print to PDF
o Metropoliassa valitse PDF-XChange Printer

Microsoft Print to PDF

PDF-XChange Printer

= Print = Print
General General

Select Printer Select Printer
= Adobe PDF =2 Micmsoﬁ Print to PDF : = Microsoft XPS Decument Writer :'EToshiba Color Print A3 ot
= Datamax E-4203 = Microsoft XPS Document Writer =PDF-XChange Printer 2012 = Tashiba Calor Print Ad ot
R Fax =2 OneNote for Windows 10 = Send To OneMote 16 :EToshiba Print A3 on PAPE
< > < >
Status: Ready [CIPrintto file Preferences Status: Ready [IPrinttafile | Preferences
Location: Location:

Comment Find Printer.. Comment: Find Printer...

Page Range Page Range

@Al Number of copies: |1 = ® Al Number of copies: |1 o

Selection Current Page Selection Current Page
Orages: ] Gollate OPages: ol
ges: ollate I I I

Enter sith I b I 1Y 22l 33 - ) ) 1 52 53
nter either a single page number or a single Enter either a single page number or a single 1 2 3
page range. Forexample, 5-12 page range. For example, 5-12




PDF:n tekemisen jalkeen tallenna PDF aina samalla nimella (ei tule turhia pdf-tiedostoja koneellesi),
avaa pdf (Adobe Acrobat Reader) ja tulosta print-komennolla tarratulostimellesi.

tarratuloste.pdf - Adcbe Acrobat Reader DC
File Edit View Window Help

Home  Tools tarratuloste.pdf X

B Y 8 X Q

200
LiU

Valitse kaytossasi oleva tarratulostin (esim. Datamax, Attune) ja tulosta.

Print X
Prmter:| Datamax E-4203 V| | Properties | | Advanced | Help @
Copies: |1 % [ Print in grayscale (black and white)

[[] Save ink/toner 0]
Pages to Print Comments & Forms
OF] |Document and Markups w
Current page 8
Pages |1
» More Options Document: 296,7 x 208,9mm
Page Sizing & Handling (1)
| Size | | Poster | | Multiple | | Booklet |
OFit 36,29 x 23,02 mm
> (®) Actual size

(O Shrink oversized pages

(0) Custom Scale: |100 %

[] Choose paper source by PDF page size

Orientation:
(O Auto portrait/landscape

7 (®) Portrait

(O Landscape

Page1of1

Print | | Cancel |




1.2.2  Chromella tulostaminen
Klikkaa Print label, jonka jalkeen naet tuloksen Chrome-selaimessa.

< c

200
LIU

655
LAN

510
LAU

240
KAN

@ httpsi/fappl.3amkkoha.cscfifco X +

8 appil.3amkkoha.cscfifcgi-binfkoha/plugins/run.pl?class=... Y& M e :

— O >

Mew tab Ctrl+T
Mew window Ctrl+MN
New incognito window  Ctrl+Shift+N
History 4
Downloads Ctrl+]
Bockmarks 4
Zoom - 100% - b
Print... Ctrl+P
Cast...
Find... Ctrl+F
Mare tools 4

C
Edit Cut Copy Paste

WE
Settings
Help 4
Exit

Tehd&dan PDF painamalla Print - Save as PDF, muuta arvot seuraavasti:

Print

Destination

Pages

Layout

Mare settings

Paper size

Pages per sheet

Margins

Scale

Opticns

2 pages

B saveasPODF -
All -
Portrait -

A~
A4 -
1 -
MNone -
Custom -

130 =

-

[ Background graphics

Destination: Save as PDF
Pages: All

Layout: Portrait

More settings

Paper size: A4

Pages per sheet: 1
Margins: None

Scale: Custom 130




PDF:n tekemisen jalkeen tallenna PDF aina samalla nimella (ei tule turhia pdf-tiedostoja koneellesi),
avaa pdf (Adobe Acrobat Reader) ja tulosta print-komennolla tarratulostimellesi.

tarratuloste.pdf - Adcbe Acrobat Reader DC
File Edit View Window Help

Home Tools tarratulostepdf X

B Y 8 B Q

200
LU

Valitse kaytdssasi oleva tarratulostin (esim. Datamax, Attune) ja tulosta.

Print X
Prmter:| Datamax E-4203 V| | Properties | | Advanced | Help @
Copies: |1 % [ Print in grayscale (black and white)

[[] Save ink/toner 0]
Pages to Print Comments & Forms
OF] |Document and Markups w
Current page 8
Pages |1
» More Options Document: 296,7 x 208,9mm
Page Sizing & Handling (1)
| Size | | Poster | | Multiple | | Booklet |
OFit 36,29 x 23,02 mm
> (®) Actual size
(O Shrink oversized pages
(0) Custom Scale: 100 %

[] Choose paper source by PDF page size

Orientation:
(O Auto portrait/landscape

7 (®) Portrait

(O Landscape

Page1of1

Print | | Cancel |




1.3 Tarraerien poistaminen
Tulostamisen jalkeen valmis tarraera on tuhottava Tyokalut->Tarrojen luonti toiminnon kautta.

Etusivu » Tydkalut » Tarrojen luonti

Tydkalujen etusivu e
» Y | + Uusi- [# Kasittele -

Asiakkaat ja lainaus

» Kommentit Tarrojen erdajot
» Kirjastokorttien luonti Asettelut
Luettelo Tarrapohjat

» Inventaario Tulostinprofiilit

» Tarrojen luonti

Klikkaa Késittele -> Tarrojen erdajot ja klikkaamalla poista

+ Uusi+ | # Kasitiele + |

Saatavana Tarojen eraajot

Asettelut
Showing 1to 1 of Tarrapohjat ntries « First < Previous Next » Last » Search % Clear filter
Tulostinprofiilit
Eraajon tunnus Kuvaus - Niteita \L Toiminnot
134 4 & Muokksa || @ Poista

Showing 1to 1 of 1 entries « First < Previous Mext » Last »

Vie valitut




2 Asetukset Datamax E-4203 ja E-4204 ja Attune —kirjoittimille

2.1 Printing Preferences — Sivun asetukset

- Luo uusi tarramalli alusta tai muokkaa olemassa olevaa tarrapohjaa.

m Datamax E-4202 Printing Preferences >

Sivun asetukset  Kuvat  Tulostusmateraali  Asetukset Tietoja

Tulostusmateriaali
Mirmi: Signum (38.0 mm x 25.0 mm) v
Lusi.... Muokkaa... Poista...
Esikatselu Suunta Tehosteet
(®) Pysty [ Kaanteiskuva
(O Vaaka [ Negatiivikuva
O Pysty 180°
(O Vaaka 180°
Esiasetus
Nimi: <MNykyasetukset ~ Hallirta ...

Lisaasetukset. ..

= 1598-2016 Seagull Scientific, Inc.
BarTender® {arachjelmiston tekijat.

Cancel Apply Help

Muokkaa:..Tarrattoman osan leveydet = Jos haluat tarratekstid keskemmalle, muutoksen voi tehd&
printteriasetuksissa Lisdasetukset Siirtyma vaakas. TAl Kohassa Label Maker -pluginissa olevaan Layout-
tiedostoon.

e Jos haluat tehdd muutoksia Kohan tarramalleihin, tee AINA ENSIN KOPIO ALKUPERAISESTA
MALLISTA Finn-ID 38 mm x 25 mm (Arial 12px) ja nimea uusi layout haluamallasi tavalla.

Muckkaa tulostusmateriaalia >

Tulostusmateriaali Esikatzelu

Sigrum | [

Tyyppi: | Muctoonleikatut tamst w

Mimmi:

Tamakoko

- s

Tarattoman osan leveydet

Penuta Ohie




2.2 Printing Preferences — Sivun asetukset — Lisdasetukset

- Siirtyma vaakas.

- Siirtyma pystys.

Muuta arvoa tarvittaessa: mikali haluat tarran tekstin ensimmaisen rivin alkavan ylempas, lisaa (-) arvoa, tai jos
haluat tekstin tippuvan alemmaksi (vdhenna (-)arvoa.

- Toinen tapa saataa tarraan tulevan tekstin alkamiskohtaa, on tehda se Kohan Label Makerissa olevassa
tarramallissa (layout).

2.2.1 Haaga-Helian Datamax, kun tulostetaan tarramallille (layout) Finn-ID 38mm x 25mm (Arial 12)
= Datamax E-4203 Printing Preferences x

Sivun asetukset  Kuyat Tulostusmateriaali  Asstukset  Tistoja

Tulnstiismatenaali

M Lisdasetukset ? >

Tulostusasema  Kayttdjan komennot  Ohjainasstuksst  Lapivienti

Aseman saato

Siityma vaakas:
Siirtyma pystys:

Suunnan saato
B Oletussuurta; 0 ~

Conca | [N [ riw

QK Cancel Apply Help

2.2.2 Haaga-Helian Datamax, kun tulostetaan tarramallille (layout) Haaga-Helia Finn-ID 38mm x 25mm
(Arial 12) JA/TAI Haaga-Helia_ MALMI Finn-ID 38mm x 25mm (Arial 16)
Lisdasetukset ? x

Tulostusasema  Kayttajan komennot  Ohjainasetukset  Lapivierti

Aseman saato

Siityma vaakas:
Siittyma pystys:

Suunnan saato

Cletussuunta: I e

Cancel Apply Help



2.2.3 Haaga-Helian Attune-kirjoittimet, kun tulostetaan tarramallille (layout) Haaga-Helia Finn-ID 38mm

x 25mm (Arial 12) — Haaga, Pasila ja Porvoo sekd Haaga-Helia_ MALMI Finn-ID 38mm x 25mm
(Arial 16)

Attunessa on samat asetukset tdssa kohtaa.

Lisdasetukset ? >

Tulostusasema  Kayttajan komennot  Ohjainasetukset  Lapiviert

Aseman saato

Siityma vaakas:

Suunnan saato

Qletussuunta: o e

Cancel Aoply Help

2.2.4 Metropolian Datamax
-tarrakoko 38x25cm (Arial)

Lisdasetukset X

Tulostusasema ~ Kayttajan komennot Ohjainasetukset ~Lapivienti
Aseman saato
Sirtyma vaakas:
seoms s
Suunnan saato _
Oletussuunta: 0 v

11



2.3 Printing Preferences — Kuvat

=0 Datarmax E-4203 Printing Preferences

Sivun asetukset  Kuvat  Tulostusmateriaali

Tarkkuus:
Rasterainti

8.0 pistetta/mm x 8,0 pistetta/mm

(®) Ei mitaan

() Rasteri

() Jarjestetty

S () Mlgebralinen

() Hajotus
Latterasterointi

Varien saato...

Vari

Varien hallinta: Yksivarinen

\farien rekisterdinti. .

Cancel

Asetukset  Tietoja

Rasteroinnin asetukset...

Pistevarien asetukset.

Apply

Help

2.4 Printing Preferences — Tulostusmateriaali (Datamax)

- Tarratunnistin: Tarravalike

- Tulostuksen jalkeinen toiminto: Repaisy

- Ylasiirtyma: 0 mm ja Repaisyn siirtyma: 19.1 mm
- Tulostusasetukset: Kaksoispuskuri

f=n Datarnax E-4203 Printing Preferences >

Sivun asetukset  Kuvat  Tulostusmateraali — Asetukset  Tietoja

Materiaaliasetulcseat

Tamatunnistin: Tamavalike ~

Kayta nykoyisia asetuksia

Materaalin kasittehy

Tulostuksen = ~
jalkeinen toiminta: Repsisy

Joka sivun jalkeen

1 =
Vst Repsiom siyms:
Tulostusasetukset
Kalesoispushun

Cancel Apply Help




2.5 Printing Preferences — Tulostusmateriaali (Attune)

Toimii, kun tulostetaan tarramallille (layout)

- Haaga-Helia Finn-ID 38mm x 25mm (Arial 12) — Haagan, Pasilan ja Porvoon tarrat
- Haaga-Helia_ MALMI Finn-ID 38mm x 25mm (Arial 16) - Malmi

[;%.! Bar Code Printer TT033-60 Printing Preferences et

Sivun asetukset  Kuvat Tulostusmateriaali - Asetukset  Tietoja

Materaaliasetukset
Tapa: Lampomenetelma ~

Tyyppi: Tamat (valikkeet) v
Valin korkeus: Walin sityma:
Materaalinkasitely
Tulostuksen jalkeinen toiminto: | Repaisy -
Joka sivun jalkeen
Syoton siintyma:

Sijainnin saadat
[] Kayta nykyisia tulostinasetuksia

Siirtyms pystys:

Cancel Apply Help

2.6 Printing Preferences — Asetukset
- Kirj.pdan lampdatila (Datamax, 10 & Attune 7). Mita isompi arvo, sen tummempana teksti tulee tarraan
r;é; Datamax E-4203 Printing Preferences *

Sivun asetuksst  Kuvat  Tulostusmateraali  Asetukset  Tietoja

Tulostusnopeus
Kayta nykyisia tulostinasetuksia

Kirj paan lampatila

[] Laheta tyén mukana
Kuva-asetukzet
Koodaus: Automaattinen w~

Cancel Aoly Help




2.7 Printing Preferences — Tietoja
- Tarkista, etta tulostimen ajurit ovat vahintaan kuvan mukaiset, versio 7.4.2 tai myéhempi
- Asenna uudempi ajuri, jos nayttaa siltd, etta kirjoitin ei tottele yhtdan mitdaan enaa.

e Datamax E-4203 ja E-4204: https://www.seagullscientific.com/downloads/printer-
drivers/datamax-e-4203/
e Attune: toimiva ajuri Generic_7.3.5_M-3.exe
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Sivun asetukset  Kuvat  Tulostusmaterizali  Asetukset  Tietoja |

Versio x
Tulostimet Maaritykset Tulostusmaterizalit Viivakoodit
Versio Jarjestelma Asetukset Ohijelma Portit

Tulostin: Datamax E-4203
Portt: USBO01

Tuote: Datamax DPL Driver
Versio: 7.4.2

Koontiversion tavoite: x64

Koontiversion paivamaara: 832016, 3:59 FM

Copyright (c) 1998-2016 Seagull Scientific, Inc.
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Tallenna... Paivita

oK [T Cancel | Bpply | | Help [T
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3 Ohjainasetusten tuonti ja vienti tarvittaessa

- Jos teet toimivat asetukset tulostimelle, voit vieda ne kdtevasti toiseen samanlaiseen tulostimeen.
- .sds-tiedosto, esim. Haagassa vanha Datamax, jonka ohjainasetukset voisi tuoda vastaavaan Datamaxiin.

3.1 Printer properties — Tyokalut - Ohjainasetukset
& Datamax E-4203

Manage your device (@ Get help

Printer status:  Default

QOpen print queue Set as default

Print a test page

Run the troubleshooter

Printer properties @ Datamax E-4203 Properties X
o General Sharing Ports Advanced Colour Management
Printing preferences S Fontit Tydkalit Teae
Hardw: i Tulostin
ardware properties Tulostus *  Toimenpidew  Maaritykset v
Ohjain
Ohjainasetukset. .. Lokiasetulset... Lk
Tilan valvorta... Valimuistin hallinta... Ohjainase ! x
Hallinto  Verkoasetuksst Alueelliset asstukset  Tulostimen mazritykset
Tuonti ja vienti
[] Asetukset Verkoasetukset
[/] Esiasetukset Viivakoodifortit
[ Fontin korvikkeet
[ Ladatut fortit
[v] Tulostusmateriaalin koot
[ Tulostusmaaritykset
[] Valinnaiset fortit
Tuo... Vie... Palauta oletusasetukset...
QK Cancel Apply Help j
QK Cancel Apply Help
Tuo > Hae haluttu .sds —tiedosto esim. yhteiseltd verkkolevyltad tms.
=g Open
u i <« Koha * Selkdtarrat » Koha 20.06 W ] £ Search Koha 20.06
Organise = MNew folder == -
Fay
. i Mame Date modified Type Size
& Onelrive yp -
. D haagal91120.5ds 8.11.202017.03 SD5 File KB
= This PC

Tuonnissa menee hetki ja kun se on valmis, tulee ao. ikkuna:

Tuontitulokset *
o Asetukset: Kylld Kun muutat tulostinasetuksia, muista klikata
Esiasetukset: 0
Fontin korvikkeet: 0 ensin Apply ja lopuksi OK. Ndin muutokset
Ladatut fontit: O
Tulostusmateriaalin koot 4 astuvat VOimaan!

Tulostusmadritykset: Kylld
Valinnaiset fontit: 0
Verkkoasetukset: Kylld
Viivakoodifontit: 1

T TRT T




4 Tarrapohjat ja asettelumallit 3AMK-Kohan Label Maker -liitannaisessa

4.1 Template: Finn-ID 38mm x 25mm (Padsana kokonaan)

[% FOREACH item IN items %]
[% IF loop.index % 1 == 0 %]
[% SET label_index = 1 %]
[% UNLESS loop.first %]
</span>
[% END %]
<span class="page">

[% END %]

<div class="label label[% label_index %]">
[% item.itemcallnumber.replace('*(\S+)\s+(\S+).*', 'S1<br>52') %]
</div>
[% IF loop.last %]</span>[% END %]
[% SET label_index = label_index + 1 %]

[% END %]

4.2 Template: Finn-ID 38mm x 25mm (Padsana 3-kirjaiminen)

[% FOREACH item IN items %]
[% IF loop.index % 1 == 0 %]
[% SET label_index = 1 %]
[% UNLESS loop.first %]
</span>
[% END %]
<span class="page">

[% END %]

<div class="label label[% label_index %]">
[% item.itemcallnumber.replace('A(\S+)\s+(\5{0,3}).*', 'S1<br>$2") %]
</div>
[% IF loop.last %]</span>[% END %]
[% SET label_index = label_index + 1 %]

[% END %]
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4.3 Layout: Finn-ID 38mm x 25mm (Arial 12)

html, body, div, span, h1 {
margin: 0;
padding: 1;
border: 0;

}

body {
width: 43mm; /* Width of label page */
height: 30mm; /* Height of label page */
font-family: Arial;

}

-page {
padding-top: 6mm; /* Height from top of page to top of first label row */
margin-left: 6mm; /* Width of gap from left of page to left edge of first label column */

page-break-after: always;
clear: left;
display: block;

Jabel {
width: 38mm; /* Width of actual label */
height: 25mm; /* Height of actual label */
margin-right: Oin; /* Distance between each column of labels */

float: left;

text-align: left;
font-weight: bold;
font-size: 12px;
overflow: hidden;

/* Uncomment for testing and debugging */
/* outline: 1px dotted; */
}

.page-break {
clear: left;
display: block;
page-break-after: always;

}



4.4  Layout: Finn-ID KAPEAMPI 36mm x 23mm (Arial 12)

html, body, div, span, h1 {
margin: 0;
padding: 1;
border: 0;

}

body {
width: 38mm; /* Width of label page */
height: 28mm; /* Height of label page */
font-family: Arial;

}

.page {
padding-top: 6mm; /* Height from top of page to top of first label row */
margin-left: 5Smm; /* Width of gap from left of page to left edge of first label column */

page-break-after: always;
clear: left;
display: block;

label {
width: 36mm; /* Width of actual label */
height: 23mm; /* Height of actual label */
margin-right: Oin; /* Distance between each column of labels */

float: left;

text-align: left;
font-weight: bold;
font-size: 12px;
overflow: hidden;

/* Uncomment for testing and debugging */
/* outline: 1px dotted; */
}

.page-break {
clear: left;
display: block;
page-break-after: always;

}



4.5 Layout: Haaga-Helia Finn-ID 38mm x 25mm (Arial 12)

html, body, div, span, h1 {
margin: 0;
padding: 1;
border: 0;

}

body {
width: 43mm; /* Width of label page */
height: 30mm; /* Height of label page */
font-family: Arial;

}

-page {
padding-top: 3mm; /* Height from top of page to top of first label row */
margin-left: 6mm; /* Width of gap from left of page to left edge of first label column */

page-break-after: always;
clear: left;
display: block;

label {
width: 38mm; /* Width of actual label */
height: 25mm; /* Height of actual label */
margin-right: Oin; /* Distance between each column of labels */

float: left;

text-align: left;
font-weight: bold;
font-size: 12px;
overflow: hidden;

/* Uncomment for testing and debugging */
/* outline: 1px dotted; */
}

.page-break {
clear: left;
display: block;
page-break-after: always;

}



4.6 Layout: Haaga-Helia_ MALMI Finn-ID 38mm x 25mm (Arial 16)

html, body, div, span, h1 {
margin: 0;
padding: 1;
border: 0;

}

body {
width: 43mm; /* Width of label page */
height: 30mm; /* Height of label page */
font-family: Arial;

}

.page {
padding-top: 2mm; /* Height from top of page to top of first label row */
margin-left: 8mm; /* Width of gap from left of page to left edge of first label column */

page-break-after: always;
clear: left;
display: block;

label {
width: 38mm; /* Width of actual label */
height: 25mm; /* Height of actual label */
margin-right: Oin; /* Distance between each column of labels */

float: left;

text-align: left;
font-weight: bold;
font-size: 16px;
overflow: hidden;

/* Uncomment for testing and debugging */
/* outline: 1px dotted; */
}

.page-break {
clear: left;
display: block;
page-break-after: always;

}



5 Painostarran tulostaminen Kohassa

5.1 Template: Painostarra

[$ FOREACH item IN items %]
[% IF loop.index $ 1 == 0 %

[$ SET label index =1

[$ UNLESS loop.first %]
</span>

[$ END %]

<span class="page">

[ END %]

<div class="label label[% label index %]">
[% item.itemnotes nonpublic %]
</div>
[% IF loop.last %]</span>[% END %]
[% SET label index = label index + 1 %]
[¢ END %]

5.2 Layout: Painostarra_Haaga-Helia Finn-ID 38mm x 25mm (Arial 10)

html, body, div, span, hl {
margin: 0;
padding: 1;
border: 0;

}

body {
width: 43mm; /* Width of label page */
height: 30mm; /* Height of label page */
font-family: Arial;

}

.page {
padding-top: 3mm; /* Height from top of page to top of first label row */

margin-left: 3mm; /* Width of gap from left of page to left edge of first label
column */

page-break-after: always;
clear: left;
display: block;

}

.label {
width: 38mm; /* Width of actual label */
height: 25mm; /* Height of actual label */
margin-right: 0in; /* Distance between each column of labels */

float: left;

text-align: left;
font-weight: bold;
font-size: 10px;
overflow: hidden;

/* Uncomment for testing and debugging */
/* outline: lpx dotted; */

.page-break {
clear: left;
display: block;
page-break-after: always;

}



5.3 Painostarran tulostaminen

Joissakin kirjastoissa lisataan erillinen painostarra mm. kurssikirjoihin, joista on useita painoksia ja joiden
painoksia on hankala hyllyssd erottaa muuten toisistaan. Painostarran voi askarrella Dymolla tai Wordin avulla
tarra-arkeille, mutta myds Datamax-tyyppisille [amposiirtotulostimille tekstin tulostaminen onnistuu Kohan kautta
- tosin vahan mutkikkaasti. Valmista, sopivaa PDF-pohjaa voi myds muokata esim. Adobe Acrobat Pro -ohjelmalla,
ja se onkin nopea tapa.

Seuraavat mallit sopivat Haaga-Helian kirjoittimien asetuksille. Painostarraa tulostaessa ei tarvitse vaihtaa
kirjoittimen asetuksia tms.

1. Luo Kohaan tarratulostusta varten hupitietue, jossa on 1 nide.
2. Laita niteen viivakoodiksi jokin helppo fraasi tai numerosarja, esim. painos.

Tarratulostus, painostarra Kohassa / Johanna Miettunen
Aineistolaji: [ Teksti

Language: Finnish

Julkaisutiedot: Helsinki - J.Miettunen, 2020

Kuvaus: 16. uud. p. 2015

Sisahotyyppi: teksti Mediatyyppi: kaylettavissa ilman laitetta Tallennetyyppi: nide
Asiasanat mallit| kifjastojarjestelmat | tarrat | tulostus

MARC preview: Nayta

Avaa Haaga-Helian Finnassa

Avaa Laurean Finnassa

Avaz Metropolian Finnassa

Items (1) Holdings (0) Descriptions (1) Hankintatiedot

Y Activate filters | v Valitse kaikki | X Tyhjenna kaikki

Showing 1to 1 of 1 entries  Search: 9 Tyhjenna suodatin 8% Sarakkest g Vie
+ | Aneistolaji « Noldings . NYKYInen . oo inasto - Kokoelma : | Luokka - Tila: Imeisin B Date 1ast .\ akooic | V1ESY
record kirjasto havainto accessioned borrowed virkailijalle
Laina-aika 0 Haaga- Haaga-Helia Haaga-Helia | vaihda Not 25.02.2020 | 25.02.2020 painos 3.uud. p. - # Muokkaa
O vk Helia Haaga = Haaga painostieto | for 2020
Késikirjasto x-kenttdan  loan

Showing 1to 1 of 1 entries

3. Lisaa painostieto niteen x-kenttaan ja vaihda se tarpeen mukaan sellaiseksi, kuin tarvitset.

o - Full call number |uaih|:|a painostieto x-kenttdan |

p - Barcode |painns |

t - Copy number |

u - Uniform Resource ldentifier |

w - Price effective from |2020_02_25

|
|
v - Cost, replacement price | |
|
|

X - Non-public note |3_ uud. p. — 2020

Y- Koha item tfpe Laina-aik. *® Pakollinen fieto

z - Public note | |

4. Tulosta 3. uud. p. -2020 lisatarra kuten tulostaisit selkatarroja
a. Luo tarraerd Kohassa Tarrojen luonti -osiossa, jonne lisdat viivakoodin 'painostarra’
b. Label Makerissa klikkaa Print batch
c. valitse tarraera, jossa painostarra on
d. valitse oikea Template, esim. Painostarra
e. valitse oikea layout, esim. Painostarra_Haaga-Helia....

Template: | Fainostarra v|

Layout: | Fainostarra_Haaga-Helia Finn-I0 38mm x 25mm (Arial 10) v|

f. Tee tulostus loppuun Firefoxilla tai Chromella, kuten selkatarrojen kohdalla.
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5.4 Painostarran PDF-tiedoston muokkaaminen

Edella kuvattu tapa on monivaiheinen, mutta silld saa kuvan mukaisen tarran. Tapa toimii, jos kaytdssa
ei ole PDF:n muokkausohjelmaa.

Painos- ja selkatarrapohjan voi tehda PDF:4a muokaten.

Liitteena on yksi malli pohjasta, joka toimii ohjeen Haaga-Helian kirjoitinten asetuksilla. Esim. 38mm x 25
mm -tarraan painostarratekstia saisi mahtumaan 2 kpl per tarra helposti, kun PDf-tiedostoa muokkaa ja
sommittelee kummankin rivin tiedot niin, ettd ne tulostuvat kirjoittimella siististi.

Painostarra_Haaga-
Helia FinnID_Arial10
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6 Label Maker -tyokalun (pluginin) asentaminen ja ByWater Solutions -
ohjemateriaali

Label Maker -plugin on ByWater Solutions -yrityksen tekema. Se 16ytyy GitHubista.

¢ GitHub: https://github.com/bywatersolutions/koha-plugin-label-maker
e KPZ-file: https://github.com/bywatersolutions/koha-plugin-label-maker/releases

1. Mene Kohassasi Yllapito — LiitAnnaiset ja lisda plugin. /cgi-bin/koha/plugins/plugins-home.pl Plugin
on tassa yhteydessa viimeisin KPZ-tiedosto Githubissa.

Jos litdnnaisten lisddminen ei ole mahdollista, ota yhteyttd Koha-yllapitajaasi.

X Lataa litdnn&inen @ \iew plugins by class =
Liitannaiset
Suurin
Nimi Kuvaus Tekija Llltanna_lsen Minimi Knha- Koh_a- VII_ITIE_ISII"I Toiminnot
Versio versio version paivitys
numero
Label Maker An alternative label creator for | Kyle M Hall 0.06 17.05.00.000 19.12.2018 || 1oiminnot «
Koha powered by HTML and
Css

Klikkaa nappulaa Toiminnot — Kaynnista tydkalu

Kopioi kayttdosi ohjeessa olevia mallipohjia, jos tarvitset samanlaisia tarroja ja/tai sinulla on
samantyyppisia kirjoittimia kaytossa.

4. Anna kirjaston henkilékunnalle virkailijaoikeuksissa oikeudet kayttaa tydkaluja: Use tool plugins

wn

] Kohan liitannéiset (o/lugins)
L] Use report plugins (report)
Use tool plugins {fool)
(] Configure plugins (configure)

] Manage plugins { install / uninstall } (manage)
5. Label Maker I6ytyy virkailijoille Kohasta Tyokalut — Muut tydkalut - TyOkaluliitannaiset

ByWater Solutions -blogit ja videot tytkalusta

Osa 1: https://bywatersolutions.com/education/label-creator-plugin

Osa 1, video: Label Maker Koha Plugin Part 1

Osa 2: hitps://bywatersolutions.com/education/using-the-label-plugin-in-koha-part-2
Osa 2, video: Label Maker Plugin Koha Part 2

Hyva kaytanto on pitda mallipohjat ja tehda niista kopioita oman kirjaston tarpeita varten. Pluginin
mukana tulee 2 templatea ja layoutia: Avery Standard Labels ja Basix 55-459-007 (&la tuhoa niita, jos
mahdollisesti tulee jossain vaiheessa tarve luoda niiden kaltaisia tarroja.

Hyddyllisia linkkeja

Conversion of Measurement Units

CSS Tutorial (for padding, margins etc.)
CSS Web Safe Fonts

Font families

Kiitos Andrii Vashchuk koodinpatkista ja paasanaleikkuristal
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